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Paper Set 1 · 11 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
The ratio of the present ages of A and B is 7 : 5. After 6 years from
now, the ratio of their ages will become 9 : 7. Find the present age of
A.

A.  C. 14 years

B.  B. 21 years

C.  A. 28 years

D.  D. 35 years

✓

Q2 Quant
A man in his journey, covers the first 300 km at 90 km/hr and the
next 80 km at 120 km/hr. Find the average speed of his 380 km
journey.

A.  A. 110 km/hr

B.  D. 95 km/hr

C.  C. 100 km/hr

D.  B. 90 km/hr

✓

Q3 Quant
A shopkeeper sold two articles of equal worth at equal cost. On one
article, the gain is 15%, while he incurs a loss of 15% on the other.
What is the gain or loss in the whole transaction?

A.  A. Loss of 1.5%

B.  B. Gain of 1.5%

C.  D. No gain or loss

D.  C. Gain of 3%

✓

Q4 Quant
Bus A covers a certain distance in 10 hours at a speed of 80 km/hr.
Bus B covers 130 km more than Bus A in the same time. Find the
average speed of Bus B.

A.  B. 90 km/hr

B.  D. 91 km/hr

C.  A. 92 km/hr

D.  C. 93 km/hr

✓

Q5 Quant
If 'x' be the product of the prime numbers between 50 and 60, and
'y' be the sum of the prime numbers between 30 and 40, then find
the value of x-2y .

A.  C. 2991

B.  B. 3291

C.  D. 1286

D.  A. 2408

✓

Q6 Quant

The roots of the equation 2x2 − 6x + 37 = 0 are:

A.  C. real and equal

B.  B. rational

C.  D. irrational

D.  A. imaginary

✓

Q7 Quant
Pipe A can fill a reservoir in 6 hours and Pipe B can fill the same
reservoir in 6 hours. Calculate the total time required to fill the
reservoir if both pipes are opened, simultaneously.

A.  A. 2 hours

B.  B. 3 hours

C.  C. 4 hours

D.  D. 5 hours

✓

Q8 Quant
The values in a dataset are 2, 3, 3, 3, 4, 5, 5, 5, 6, 6, 6, 7, 9, and 11.
Find the mode(s) of the dataset.

A.  D. 3,5

B.  B. 6

C.  C. 3,5,6

D.  A. 5,6

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q9 Quant
A right circular cone and a right circular cylinder have equal base
and equal height. If the radius of the base and the height are in the
ratio 4 : 3, then the ratio of the total surface area of the cylinder to
that of the cone is:

A.  A. 14 : 9

B.  C. 19 : 7

C.  D. 13 : 14

D.  B. 11 : 8

✓

Q10 Quant
Pawan and Dinesh started a business by investing amounts of
₹2,600 and ₹1,300, respectively. If Pawan's share in the profit earned
by them is ₹640, what is the total profit (in ₹) earned by them
together?

A.  C. 960

B.  D. 910

C.  B. 1,116

D.  A. 926

✓

Q11 Quant
The average of 6.5, 10.7, 20.2 and a is 19. The value of a is:

A.  A. 38.6

B.  C. 37.6

C.  D. 39.6

D.  B. 40.6

✓

Q12 Quant
By how much is 30% of 65 greater than 25% of 35?

A.  D. 10.75

B.  B. 5.75

C.  C. 7.75

D.  A. 12.75

✓

Q13 Quant
A and B working together can do a piece of work in 5 days. B alone
can do the same work in 20 days. How long (in days) will A alone
take to do thrice the work?2556

A.  A. 20

B.  C. 40

C.  B. 60

D.  D. 80

✓

Q14 Quant

₹7,544 is divided among X, Y, and Z such that if ₹14, ₹25, and ₹85
are deducted from their respective shares, the remaining amounts
are in the ratio 20:4:11. Find X’s share after the deduction.

A.  A. ₹4240

B.  B. ₹4090

C.  D. ₹4390

D.  C. ₹4140

✓

Q15 Quant
Krish has ₹1281 with him. He divided it amongst his sons Veer and
Nitin and asked them to invest it at 10% rate of interest
compounded annually. It was seen that Veer and Nitin got same
amount after 18 and 19 years, respectively. How much money (in ₹)
did Krish give to Nitin?10090

A.  610

B.  671

C.  460

D.  771

✓

Q16 Quant
In a circle with centre O, two chords AB and BC are drawn. Points A
and C are connected to the centre O. If ∠OAB and ∠OCB are 36° and
50°, respectively, then what is the degree measure of the reflex
∠AOC?

A.  A. 207°

B.  C. 188°

C.  B. 200°

D.  D. 220°

✓

Q17 Quant
Ramesh sells a table to Mukesh at a profit of 25%, and then Mukesh
sells it to Jaybind at a profit of 60%. If Jaybind pays ₹1,286 for the
table, its cost price (in ₹) for Ramesh is:

A.  B. 643

B.  C. 645

C.  A. 640

D.  D. 642
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✓

Q18 Quant

If , then on simplification, the value of Y is

A.  

B.  

C.  

D.  

✓

Q19 Quant

1785

A.  

B.  

C.  

D.  

✓

Q20 Quant

A.  A. 41.75

B.  B. 38.75

C.  C. 35.75

D.  D. 39.75
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GA

✓

Q21 GA
Who was the first Governor-General of India under the Charter Act
of 1833?

A.  C. Lord William Bentinck

B.  D. Lord Dalhousie

C.  A. Lord Canning

D.  B. Lord Cornwallis

✓

Q22 GA
What is the name of the official mascot for the Khelo India Youth
Games 2025?

A.  D. Ujjwala

B.  B. Sheru

C.  C. Cheetah

D.  A. Gajasimha

✓

Q23 GA
Who among the following is appointed as Securities and Exchange
Board of India (SEBI) Executive Director in July 2025?

A.  B. Sunil Jayawant Kadam

B.  C. Ananth Narayan G

C.  D. Amarjeet Singh

D.  A. M. Rajeshwar Rao

✓

Q24 GA
In mass wasting processes, the movement of material from one
place to another is aided primarily by which of the following?

A.  C. Hydraulic action

B.  B. Gravity

C.  A. Glacier plucking

D.  D. Wave action

✓

Q25 GA
In September 2025, the Odisha government promulgated which of
the following policies to fast-track energy storage infrastructure and
facilitate smooth integration of renewable energy into the state's
power grid?

A.  B. Odisha Solar Integration and Storage Policy, 2025

B.  D. Odisha Pumped Storage Project Policy, 2025

C.  C. Odisha Green Energy Corridor Policy, 2025

D.  A. Odisha Grid-Scale Battery Storage Policy, 2025

✓

Q26 GA
The angle between the principal axis and a ray of light incident
parallel to it is ______.

A.  B. 0°

B.  D. 45°

C.  C. 90°

D.  A. Depends on curvature

✓

Q27 GA
Which condition is necessary for methane to undergo a substitution
reaction with chlorine?

A.  D. Presence of acid

B.  B. Presence of base

C.  C. Presence of sunlight

D.  A. Presence of water

✓

Q28 GA
Who among the following is the author of the book “Why the
Constitution Matters”?

A.  A. Justice Ranjan Gogoi

B.  C. Justice U.U. Lalit

C.  B. Former CJI D.Y. Chandrachud

D.  D. Former CJI P.N. Bhagwat

✓

Q29 GA
The maintenance process for survival is necessary because
_____________.

A.  B. They help in the ageing process

B.  D. They prevent cellular damage and ensure survival

C.  C. They stop respiration temporarily

D.  A. They help autotrophs to do photosynthesis

✓

Q30 GA
In September 2025, India signed a Bilateral Investment Treaty (BIT)
with which country?

A.  D. Australia

B.  A. Israel

C.  B. Canada

D.  C. United Arab Emirates
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✓

Q31 GA
The northern range of the Odisha Police executed “Operation Gaja”
between August 25 and September 1, 2025 across five districts;
which one of the following was NOT among those districts?

A.  D. Sambalpur

B.  A. Balangir

C.  C. Jharsuguda

D.  B. Khurda

✓

Q32 GA
The core principle of sustainable development related to fairness
between different time periods (generations) is known as:

A.  D. Interdependence

B.  B. Inter-generational equity

C.  A. Planetary boundaries

D.  C. Resource allocation

✓

Q33 GA
In which of the following years, before India’s Independence, was
Odisha established as a separate province?

A.  A. 1912

B.  C. 1922

C.  B. 1936

D.  D. 1941

✓

Q34 GA
Which Brahmana texts are associated with the Yajurveda?

A.  A. Taittiriya and Shatapatha

B.  B. Panchavimsha and Jaiminiya

C.  C. Gopatha and Taittiriya

D.  D. Aitareya and Kaushitaki

✓

Q35 GA
The need for rural credit arises mainly due to which structural
feature of agricultural production?

A.  C. High labour productivity

B.  A. Short production cycles

C.  D. Long gestation period

D.  B. Guaranteed crop income

✓

Q36 GA
Which one of the following classical dance forms of India originated
in Kerala and is known for its elaborate costumes, facial expressions,
and storytelling based on epics?

A.  B. Bharatanatyam

B.  A. Kathak

C.  D. Kathakali

D.  C. Odissi

✓

Q37 GA
Which of the following is an atmospheric phenomenon held
responsible for the burst of the monsoon in India?

A.  D. Western Distrubances

B.  B. Easterly jet stream

C.  A. Madden-Julian Oscillation

D.  C. La Nina phenomenon

✓

Q38 GA
Which of the following acts introduced the concept of "Dyarchy" in
the provinces of India?

A.  C. Government of India Act 1935

B.  A. Government of India Act 1919

C.  B. Indian Councils Act 1861

D.  D. Indian Independence Act 1947

✓

Q39 GA
Odisha's climate is predominantly classified as:

A.  A. tropical desert

B.  B. tropical monsoon

C.  D. temperate oceanic

D.  C. subarctic

✓

Q40 GA
The Narmada River originates from which place?

A.  C. Satpura

B.  B. Amarkantak

C.  A. Brahmagiri

D.  D. Western Ghats
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English

✓

Q41 English
Select the option that can be used as a one-word substitute for the given group of words.

One who cannot die

A.  B. Mortal

B.  D. Immortal

C.  C. Biodegradable

D.  A. Perishable

✓

Q42 English
Select the option that expresses the given sentence in passive voice.

Tina paints the walls every year.

A.  B. The walls were painted by Tina every year.

B.  C. The walls have been painted by Tina every year.

C.  A. The walls are painted by Tina every year.

D.  D. The walls is painted by Tina every year.

✓

Q43 English
Select the option that can be used as a one-word substitute for the given group of words.

A place where dead bodies are kept before their burial or cremation

A.  A. Cemetery

B.  B. Morgue

C.  D. Mausoleum

D.  C. Vault

✓

Q44 English
In the following question, a statement has been given in brackets. You are required to replace the statement with the correct idiom given in the
options.
When the final results were announced, Tanvi suddenly became extremely happy. She (became extremely cheerful and excited) after seeing her
marks.

A.  C. Hit the sack

B.  D. Turned a blind eye

C.  B. Lost her temper

D.  A. Jumped for joy
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✓

Q45 English
Select the most appropriate ANTONYM of the highlighted word in the given sentence.

The process was tedious and took several hours to complete.

A.  B. gigantic

B.  D. boring

C.  C. exciting

D.  A. deceptive

✓

Q46 English
Identify the correct substitute for the incorrect word-segment in the given proverb.

The road to heaven is paved with bad intentions.

A.  D. The road to home is paved with good gravel.

B.  A. The road to happiness is paved with strong intentions.

C.  C. The road to hell is paved with good intentions.

D.  B. The road to hell is paved with good obedience.

✓

Q47 English
From the options given below, choose the sentence which is correctly written in indirect speech.

A.  B. She said that she would go if she has time.

B.  C. She said that she would go if she had time.

C.  D. She said that she will go if she had time.

D.  A. She said that she will go if she has time.

✓

Q48 English

Read the following passage and answer the questions.

In the fable The Bird with Two Heads, a bird is born with two heads. At first, the heads argue constantly, each wanting to eat and fly differently.
This disagreement causes confusion and prevents the bird from acting effectively. Observing the chaos, the other birds warn the two-headed
bird that it must learn to cooperate or it will suffer. Gradually, the two heads realize that they can survive and thrive only if they agree on their
actions and share responsibilities. Once they start cooperating, the bird becomes strong, capable of finding food and flying safely. The story
teaches the importance of unity, cooperation, and working together despite differences. It emphasizes that conflict within oneself or between
partners can lead to failure, while harmony and coordination bring success.

According to the fable, what was the primary catalyst that forced the two heads to transition from conflict to cooperation?

A.  B. A lack of physical strength that prevented the bird from being able to fly at all.

B.  A. The realization that their survival and ability to thrive depended on shared actions.

C.  C. A direct command from the other birds who threatened to exile the two-headed bird.

D.  D. A shortage of food in their environment that made competition impossible.
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✓

Q49 English
What lesson does the story convey about disagreement?

A.  A. Arguments make you stronger.

B.  D. Ignoring others is best.

C.  B. Cooperation is necessary for success.

D.  C. Strength is only physical.

✓

Q50 English
In this context, what does “cooperate” most nearly mean?

A.  D. Compete against each other.

B.  C. Work together for a common goal.

C.  B. Ignore problems.

D.  A. Act independently.

✓

Q51 English
Which best describes the tone of the passage?

A.  D. Serious and instructive

B.  C. Playful and humorous

C.  A. Sad and mournful

D.  B. Angry and critical

✓

Q52 English
Which option best sumarizes the passage?

A.  A. A two-headed bird fights and loses to other birds.

B.  B. A bird is born with one head and learns to share food.

C.  C. Birds avoid the two-headed bird entirely.

D.  D. A two-headed bird learns to cooperate and becomes successful.

✓

Q53 English
Choose the correct form of tense for the sentence.

Every spring, the endangered turtles ______ their eggs along this protected stretch of coastline.

A.  D. were laying

B.  B. will lay

C.  C. lay

D.  A. have laid
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✓

Q54 English
Choose the correct antonym of the underlined word.

The organisation adopted a stringent policy to regulate access to sensitive user data.

A.  A. unethical

B.  D. accountable

C.  B. lenient

D.  C. firm

✓

Q55 English
In the given sentence, four words are marked bold. Choose the word which is incorrectly spelt.

Her persistance and commitment were admired by everyone at the ceremony.

A.  C. persistance

B.  A. commitment

C.  D. admired

D.  B. ceremony

✓

Q56 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.
A.she informed us that the
B.the weather conditions did not
C.ceremony would be postponed if
D.improve by tomorrow afternoon

A.  A. ACBD

B.  C. BDCA

C.  B. CBAD

D.  D. DABC

✓

Q57 English
A statement is divided into different segments. The first segment is fixed. Rearrange the other segments to form a coherent statement.

Fixed: The growing popularity of air fryers among health-conscious consumers

P: is largely due to their ability
Q: while still maintaining taste and texture
R: to cook food with minimal oil
S: in modern kitchens

A.  B. P R Q S

B.  A. S P R Q

C.  D. Q R P S

D.  C. R S P Q
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✓

Q58 English
Choose the correct option to complete the sentence.

She suggested that he ______ more careful while handling sensitive information.

A.  C. is

B.  A. was

C.  B. be

D.  D. has been

✓

Q59 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

My cousin, who lives in Nagpur, works for a group to help _____ elderly.

A.  D. a

B.  A. an

C.  C. the

D.  B. No article required

✓

Q60 English
Select the most appropriate option to fill in the blank.

Despite warnings about the water level, he insisted on swimming _______ the river, determined to complete his endurance challenge without
any assistance.

A.  B. into

B.  A. within

C.  D. across

D.  C. in
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Digital learning has become an essential part of modern education.

A.  A. ଡି ଜି ଟାଲ ଶି କ୍ଷଣ ଆଧୁ ନି କ ଶି କ୍ଷାର ଏକ ପ୍ର ମୁ ଖ ଅଂଶ ଅଟେ।

B.  C. ଡି ଜି ଟାଲ ଶି କ୍ଷା ଆଧୁ ନି କ ଶି କ୍ଷାର ଗୁ ରୁ ତ୍ୱ ଅଂଶ ହୋଇଯାଇଛି ।

C.  B. ଡି ଜି ଟାଲ ଶି କ୍ଷା ଆଧୁ ନି କ ଶି କ୍ଷା ଅଂଶ ହୋଇଯାଇଛି ।

D.  D. ଡି ଜି ଟାଲ ଶି କ୍ଷା ଆଧୁ ନି କ ଶି କ୍ଷାର ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଅଂଶ ହୋଇଗଲା।

✓

Q62 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ଲୋଚନ

A.  B. ନାସା

B.  A. ମନ

C.  D. ହସ୍ତ

D.  C. ନୟନ

✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୋ ବାପା ରୁ ଣ ନେଇ ଆମ ପାଇଁ  ଘର କରି ଛନ୍ତି  ।

A.  B. My father has built a house for us by taking loan.

B.  A. My father is making a house for us on credit.

C.  D. My father was making a house for us .

D.  C. My father will build a house for us on credit.

✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୋ ଭଉଣୀ ର ବାହାଘର ପାଇଁ  ଆମେ ବହୁ ତ ବ୍ୟସ୍ତ ଅଛୁ  ।

A.  D. We were very busy for my sister's wedding.

B.  B. We had been busy for my sister's wedding.

C.  C. We are very busy for my sister's wedding.

D.  A. We will be very busy for wedding.
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✓

Q65 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

କାଳି ଜାଈ ହେଉଛନ୍ତି  ଓଡ଼ି ଶାର ଅଗଣି ତ ଲୋକଙ୍କ ପୂ ଜ୍ୟ ଦେବୀ | ବି ଶେଷକରି  ଏସି ଆର ସର୍ବ ବୃ ହତ ଲୁ ଣି ଆ ଜଳ ହ୍ର ଦ ଚି ଲି କା ହ୍ର ଦ ପାଖରେ ବସବାସ କରୁ ଥି ବା ଲୋକ ମାନଙ୍କ ପାଇଁ  ସେ ହେଉଛନ୍ତି
ଅଗ୍ର ପୂ ଜ୍ୟ । ହ୍ର ଦର ଏକ ଛୋଟ ଦ୍ୱୀପରେ ଅବସ୍ଥି ତ ପ୍ର ସି ଦ୍ଧ କାଲି ଜାଈ ମନ୍ଦି ରକୁ  ପ୍ର ତି ବର୍ଷ  ହଜାର ହଜାର ଭକ୍ତଙ୍କ ସମାଗମ ହୋଇଥାଏ । ମନ୍ଦି ରଟି  କେବଳ ପୂ ଜାସ୍ଥଳ ନୁ ହେଁ  ବରଂ ବି ଶ୍ୱାସ, ଲୋକକଥା
ଏବଂ ଓଡ଼ି ଶାର ଗଭୀର ସାଂସ୍କୃତି କ ଐତି ହ୍ୟର ପ୍ର ତୀକ ମଧ୍ୟ ।

ସ୍ଥାନୀୟ କି ମ୍ବଦନ୍ତୀ ଅନୁ ସାରେ, କାଳୀଜାଈ ଥି ଲେ ଜାଇ ନାମକ ଜଣେ ଯୁ ବତୀ, ଯି ଏ ବି ବାହ ପରେ ଡଙ୍ଗାରେ ତାଙ୍କ ସ୍ୱାମୀଙ୍କ ଗାଁ କୁ  ଯାତ୍ରା  କରୁ ଥି ବା ବେଳେ ଦୁ ର୍ଭା ଗ୍ୟବଶତଃ, ଡଙ୍ଗାଟି  ଚି ଲି କା ପାର ହେବା
ସମୟରେ ଏକ ଭୟଙ୍କର ଝଡ଼ ଉଠି ଲା । ଡଙ୍ଗାଟି  ଅଶାନ୍ତ ପାଣି ରେ ଓଲଟି  ପଡ଼ି ଲା ଏବଂ ଜାଇ ଦୁଃ ଖଦ ଭାବରେ ବୁ ଡ଼ି ଗଲା । ବି ଶ୍ୱାସ କରାଯାଏ ଯେ ସେ ଜାଇ ନାମକ ଯୁ ବତୀ ଦେବୀ ଭାବରେ ପୁ ନର୍ବା ର
ଆବି ର୍ଭା ବ ହେଲେ ଏବଂ କାଳୀଜାଈ ଭାବରେ ପୂ ଜା ପାଇ ପ୍ର ସି ଦ୍ଧି  ଲାଭ କଲେ । ସେବେଠାରୁ , ଏହି  ଦ୍ୱୀପକୁ  ଏକ ପବି ତ୍ର ସ୍ଥଳୀ ଭାବରେ ବି ବେଚନା କରାଯାଏ,| ବି ଶେଷକରି  ମତ୍ସ୍ୟଜୀବୀ ଏବଂ
ନାବି କମାନେ ଚି ଲି କା ଯାତ୍ରା  ଆରମ୍ଭ କରି ବା ପୂ ର୍ବ ରୁ  ସୁ ରକ୍ଷା ଏବଂ ସମୃ ଦ୍ଧି  ପାଇଁ  ତାଙ୍କ ଆଶୀର୍ବା ଦ ଲୋଡ଼ି  ପ୍ରା ର୍ଥ ନା କରନ୍ତି ।

ପ୍ର ତି ବର୍ଷ , ମକର ସଂକ୍ରା ନ୍ତି  ସମୟରେ, ମନ୍ଦି ରରେ ଏକ ମହାମେଳା ଅନୁ ଷ୍ଠି ତ ହୁ ଏ | ଏହି  ଅବସରରେ ଓଡ଼ି ଶାର ବି ଭି ନ୍ନ ସ୍ଥାନରୁ  ଶ୍ର ଦ୍ଧାଳୁ  ଆସି  ପୂ ଜା ଅର୍ଚ୍ଚ ନା କରି ଥାନ୍ତି  । ତୀର୍ଥ ଯାତ୍ରୀ ମାନେ ଏହି  ମନ୍ଦି ରକୁ
ପରି ଦର୍ଶ ନ କରନ୍ତି , ପ୍ରା ର୍ଥ ନା କରନ୍ତି  ଏବଂ ସାଂସ୍କୃତି କ ପରମ୍ପରାରେ ଅଂଶଗ୍ର ହଣ କରନ୍ତି । ଲୋକଗୀତ, ନୃ ତ୍ୟ ଏବଂ ସ୍ଥାନୀୟ ହସ୍ତଶି ଳ୍ପ ଷ୍ଟଲ ସହି ତ ପରି ବେଶ ଉଜ୍ଜ୍ୱଳ ହେବା ସହ ଚତୁଃ ପାର୍ଶ୍ଵ  ହର୍ଷ  ଓ ଆନନ୍ଦ
ରେ ଭରି  ଯାଏ । ଏହି  ଉତ୍ସବ ଓଡ଼ି ଶାର ସମୃ ଦ୍ଧ ପରମ୍ପରା ତଥା ମଣି ଷ ଏବଂ ପ୍ର କୃ ତି  ମଧ୍ୟରେ ସୁ ସଜ୍ଜି ତ ସମ୍ପର୍କ କୁ  ଉଜାଗର କରି ଥାଏ। ସମୟକ୍ର ମେ କାଳୀଜାଈ ଓଡି ଶାର ଏକ ପ୍ର ମୁ ଖ ପର୍ଯ୍ୟ ଟନ ସ୍ଥଳୀ
ଭାବେ ଖ୍ୟାତି  ଲାଭ କରି ଛି  |

କାଳୀଜାଈଙ୍କ କାହାଣୀ ବି ଶ୍ୱାସ, ତ୍ୟାଗ ଏବଂ ଭକ୍ତି ର ବି ଷୟବସ୍ତୁକୁ  ପ୍ର ତି ଫଳି ତ କରେ। ଏହା ସମୁ ଦ୍ର  ସହି ତ ଲୋକଙ୍କ ଗଭୀର ଭାବପ୍ର ବଣ ସମ୍ପର୍କ  ଏବଂ ଦି ବ୍ୟ ସୁ ରକ୍ଷାରେ ସେମାନଙ୍କର ବି ଶ୍ୱାସକୁ  ମଧ୍ୟ
ପ୍ର ତି ନି ଧି ତ୍ୱ କରେ। ବର୍ତ୍ତ ମାନ , କାଳି ଜାଈ ମନ୍ଦି ର ଓଡ଼ି ଶାର କି ମ୍ବଦନ୍ତୀ ଏବଂ ସାଂସ୍କୃତି କ ସ୍ମୃତି ର ସ୍ଥାୟୀ ଶକ୍ତି ର ସ୍ମରଣକାରୀ ଭାବରେ ଦଣ୍ଡାୟମାନ ହୋଇଛି ।

କାଳି ଜାଈ ମନ୍ଦି ର କେଉଁ ଠାରେ ଅବସ୍ଥି ତ?

A.  C. କୋଣାର୍କ

B.  D. ଚି ଲି କା ହ୍ର ଦ

C.  A. ପୁ ରୀ ବେଳାଭୂ ମି

D.  B. ହୀରାକୁ ଦ ବନ୍ଧ

✓

Q66 Odia
କି ମ୍ବଦନ୍ତୀ ଅନୁ ସାରେ ଚି ଲି କା ପାର ହେବା ସମୟରେ ଜାଇଙ୍କ ସହି ତ କ’ଣ ଘଟି ଥି ଲା?

A.  D. ସେ ରାଣୀ ହୋଇଗଲେ

B.  B. ଝଡ଼ ଯୋଗୁଁ  ବୁ ଡ଼ି ଗଲେ

C.  C. ସେ ବି ଦେଶ ଚାଲି ଗଲେ

D.  A. ସେ ଜଣେ ସନ୍ଥ ହୋଇଗଲେ

✓

Q67 Odia
କାଳୀଜାଈଙ୍କୁ  ମୁ ଖ୍ୟତଃ କେଉଁ  ମାନେ ପୂ ଜା କରନ୍ତି  ?

A.  D. କୃ ଷକ

B.  C. ମତ୍ସ୍ୟଜୀବୀ ଏବଂ ନାବି କ

C.  A. ସୈ ନି କ

D.  B. ଶି କ୍ଷକ

✓

Q68 Odia
ମନ୍ଦି ରରେ ମୁ ଖ୍ୟ ପର୍ବ  କେବେ ପାଳନ କରାଯାଏ?

A.  B. ରଥଯାତ୍ରା

B.  D. ଦୁ ର୍ଗା  ପୂ ଜା

C.  C. ମକର ସଂକ୍ରା ନ୍ତି

D.  A. ଦୀପାବଳି
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✓

Q69 Odia
ଉପରୋକ୍ତ ଅଂଶରେ "ପୂ ଜ୍ୟ" ର ଅର୍ଥ  କଣ ?

A.  C. ଅଣଦେଖା

B.  B. ଅତ୍ୟନ୍ତ ସମ୍ମାନି ତ

C.  A. ପ୍ର ତି ସ୍ଥାପି ତ

D.  D. ପ୍ର ଶ୍ନ  କରାଯାଇଛି

✓

Q70 Odia
‘ହାତ ଅଳସେ ନି ଶ ବଙ୍କା’ ହି ତୋପଦେଶଟି ର ଅର୍ଥ ଲେଖ ।

A.  A. ବୃ ଥା ପରି ଶ୍ର ମ

B.  C. ଅଳସୁ ଆ ଦୁଃ ଖ ପାଏ

C.  B. ଅତି ସାମାନ୍ୟ ମଣି ଷ

D.  D. ନି ଜେ ସମର୍ଥ ହେବା

✓

Q71 Odia
ଜେଜେ ବୋଝେ ପରି ବା ନେଇ ହାଟକୁ  ଗଲେ । ଉକ୍ତ ବାକ୍ୟରେ ବି ଶେଷଣ ପଦଟି  ଚି ହ୍ନଟ କର ।

A.  B. ଜେଜେ

B.  D. ପରି ବା

C.  A. ବୋଝେ

D.  C. ହାଟ

✓

Q72 Odia
ବ୍ୟକ୍ତି  ଅପେକ୍ଷା ଦେଶ ବଡ଼ । ଉକ୍ତ ବାକ୍ୟରେ ଅବ୍ୟୟ ପଦଟି  ଚି ହ୍ନଟ କର ।

A.  B. ବ୍ୟକ୍ତି

B.  C. ଅପେକ୍ଷା

C.  D. ଦେଶ

D.  A. ବଡ଼

✓

Q73 Odia
ଜମି ଦାର ଜଣେ 'ଦାତା' ଭାବେ ପରି ଚି ତ ଥି ଲେ, ମାତ୍ର  ତାଙ୍କ ପୁ ଅ ଜଣେ ________ ସାଜି ଲା।
(ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଶବ୍ଦ ମଧ୍ୟରୁ  ସଠି କ ଶବ୍ଦ ବ୍ୟବହାର କରି  ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର)

A.  C. ଅତ୍ୟାଚାରୀ

B.  D. ଭି କାରୀ

C.  A. କୃ ପଣ

D.  B. ନେତା
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✓

Q74 Odia
ଯେଉଁ  ବି ଶେଷଣ ପଦ ବି ଶେଷ୍ୟ ପଦର ସଂଖ୍ୟା ସୂ ଚାଏ, ତାକୁ  କ'ଣ କୁ ହାଯାଏ ?

A.  A. ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  D. ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

C.  B. ପରି ମାଣବାଚକ ବି ଶେଷଣ

D.  C. ସୂ ଚନାବାଚକ ବି ଶେଷଣ

✓

Q75 Odia
'ଉଜ୍ଜ୍ୱଳ' ଶବ୍ଦର ଶୁ ଦ୍ଧ ବନାନଟି କୁ  ଚି ହ୍ନଟ କର ।

A.  B. ଉଜଳ

B.  A. ଉଜ୍ଜଳ

C.  C. ଉଜ୍ଜ୍ୱଳ

D.  D. ଉଜ୍ଜଳ୍ୱ

Computer

✓

Q76 Computer
Which of the following components performs arithmetic and
logical operations inside the CPU?

A.  C. Memory Unit

B.  D. Control Unit

C.  A. Arithmetic Logic Unit (ALU)

D.  B. Input Unit

✓

Q77 Computer
Which command in Microsoft Word 2021 creates a new blank
document ready for entering text?

A.  A. File → New → Blank document

B.  C. File → Open

C.  B. Insert → Object

D.  D. View → New Window

✓

Q78 Computer
Which is a good approach when sending a large file as an
attachment?

A.  B. Send multiple copies of the same file

B.  D. Use cloud storage links or Compress (zip) the file

C.  C. Attach each page as a separate file

D.  A. Ignore file size limits

✓

Q79 Computer
In MS Word, choose the view that is most highly recommended for
creating and managing headings and subheadings in structured
documents.

A.  D. Draft View

B.  A. Print layout

C.  B. Outline View

D.  C. Web Layout

✓

Q80 Computer

Among the following, which is an output
device?

A.  C. Trackball

B.  B. Joystick

C.  A. Digital Camera

D.  D. Plotter

✓

Q81 Computer
Which of the following is NOT an option for configuring slide
transitions in MS PowerPoint?

A.  B. Fade

B.  D. Push

C.  A. Wipe

D.  C. Fly In
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✓

Q82 Computer
A computer fails to boot because its firmware instructions are
corrupted. Which component is most likely affected?

A.  A. RAM

B.  C. ROM

C.  D. CPU

D.  B. PCB

✓

Q83 Computer
Which of the following is an example of application software?

A.  B. BIOS

B.  A. Windows Operating System

C.  D. Microsoft Word

D.  C. Device Driver

✓

Q84 Computer
Which of the following is NOT part of text formatting?

A.  D. Font size

B.  A. Font color

C.  C. Font style (bold, italic)

D.  B. Page orientation

✓

Q85 Computer
What does the cell address 'B2' refer to in a spreadsheet application
such as Microsoft Excel?

A.  B. Column B, Row 2

B.  C. Row B, Column 2

C.  D. Sheet B, Cell 2

D.  A. Workbook 2, Cell B

✓

Q86 Computer
A website is a/an ___________________________.

A.  D. physical server

B.  A. email address

C.  C. collection of web pages

D.  B. programming language

✓

Q87 Computer
What happens when you apply a template to an existing MS
PowerPoint presentation?

A.  A. It completely replaces all slides and content.

B.  C. It only changes the background without affecting text
formatting.

C.  B. It applies a new design while keeping existing slide
content.

D.  D. It converts the PowerPoint into a read-only format.

✓

Q88 Computer
What does the function =IF(A1>45, "Pass", "Fail") do?

A.  C. Always shows "Pass"

B.  D. Shows "Fail" if A1 is less than or equal to 45

C.  A. Adds A1 and 45

D.  B. Shows error

✓

Q89 Computer
In MS-Excel 2010, if excel workbook is saved in .csv format, what
is/are lost in the file?

A.  C. Cell values

B.  B. Basic formulas

C.  D. Formatting, charts and multiple sheets

D.  A. Text

✓

Q90 Computer
In MS-PowerPoint, what does setting a larger duration value do to a
slide transition?

A.  B. Makes it faster

B.  A. Makes it slower

C.  D. Disables the transition effect

D.  C. Changes it to fade only
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Reasoning

✓

Q91 Reasoning
Five people are sitting in a circle (Ram, Sham, Vaibhav, Arjun and
Kapil) facing away from the centre. Ram is sitting second to the left
of Sham. Vaibhav is not an immediate neighbour of Ram. Arjun is
sitting to the immediate right of Vaibhav.

What is the position of Kapil with respect to Vaibhav?

A.  B. Second to the left

B.  A. Immediate right

C.  D. Immediate left

D.  C. Second to the right

✓

Q92 Reasoning
In a certain code language,
‘A + B’ means ‘A is the sister of B’;
‘A * B’ means ‘A is the husband of B’;
‘A − B’ means ‘A is the mother of B’ and
‘A & B’ means ‘A is the brother of B’.

If ‘V + S * K − R & A’, how is S related to A?2439

A.  B. Mother

B.  A. Father

C.  C. Sister

D.  D. Brother

✓

Q93 Reasoning
LION is related to VSYX in a certain way based on the English
alphabetical order. In the same way, ZWCB is related to JGML. To
which of the following options is DAGF related to, following the
same logic?

A.  C. NKQP

B.  D. NKOP

C.  B. NMKO

D.  A. NHYT

✓

Q94 Reasoning
Seven boxes, I, J, K, L,W, X and Y, are kept one over the other but not
necessarily in the same order. Only three boxes are kept above J.
Only one box is kept between Y and J. Only three boxes are kept
between Y and I. I is kept at some place above J. K is kept
immediately below I. X is kept at one of the places above L. W is not
kept immediately above or below Y. Which box is kept at the
lowermost position?

A.  B. I

B.  C. J

C.  D. L

D.  A. X

✓

Q95 Reasoning
Raman starts from point A and drives 62 km towards east. He then
takes a left turn, drives 56 km, turns left and drives 64 km. He then
takes a left turn and drives 65 km. He takes a final left turn, drives 2
km and stops at point P. How far (shortest distance) and towards
which direction should he drive in order to reach point A again? (All
turns are 90-degree turns only unless specified.)

A.  A. 7 km to the North

B.  D. 8 km to the North

C.  B. 9 km to the North

D.  C. 10 km to the South

✓

Q96 Reasoning
If 1 is added to each odd digit and 2 is subtracted from each even
digit in the number 132465, how many digits will appear more than
once in the new number thus formed?

A.  D. None

B.  B. One

C.  A. Two

D.  C. Three

✓

Q97 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?

NPN OOP PNR ? RLV

A.  D. MJI

B.  B. FRT

C.  A. QMT

D.  C. KJU

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their position in the letter cluster.)11732

A.  B. AW−RQ

B.  A. UQ−MI

C.  D. HD−ZV

D.  C. RN−JF
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✓

Q99 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: Some Mountains are Hills. Some Hills are Valleys.
Conclusion I: Some Mountains are Valleys.
Conclusion II: No Mountains are Valleys.357

A.  B. Only conclusion (I) follows

B.  A. Only conclusion (II) follows

C.  C. Neither conclusion (I) nor (II) follows

D.  D. Both conclusions (I) and (II) follow

✓

Q100 Reasoning
Refer to the following series and answer the question (All numbers
are single digit numbers only. Counting to be done from left to
right.)

(Left) 5 7 9 4 2 9 3 2 6 1 3 6 7 1 5 7 9 4 2 6 7 1 2 9 3 5 7 1 (Right)

How many such even digits are there each of the which is
immediately preceded by a perfect square and immediately followed
by an odd digit? (NOTE: 1 is also a perfect square.)

A.  D. More than three

B.  C. One

C.  A. Two

D.  B. Three
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